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Find Cheap High PR Expired 

Domains - Step By Step Tutorial 

In the previous chapter of the expired domains saga, we covered Web 2.0 profiles. While those 

are great, they cannot even begin to compete with a link from a high PR expired domain. So, it's 

time for us to find some of those. Today, I will show you how you can quickly and easily find 

cheap expired domains which have amazing stats and will cost you no more than the 

registration fee. We ride. 

What You'll Learn 

 Preparing the stage - a few words about PR and the method we will use to find cheap 

quality expired domains. 

 A step-by-step tutorial on finding cheap high PR expired domains - whether you are 

looking for a single expired domain or a bunch, this is the fastest way you can find them. 

 The best practices when looking for quality expired domains - an expired domain might 

look like it is a gold nugget, but before you rush to register it, read this section. 

 A summarizing conclusion - bottom line is... 

Preparing the Stage 

First of all, if you are too lazy, or you just don't have the time, you don't necessarily have to go 

through all this manual work. There are easy-to-use tools out there which will automate the 

entire process for you and simply list the expired domains and all of their metrics in an easy to 

filter table - I am referring to Domain Hunter Gatherer. Or you can simply head over to a huge 

expired domains website such as ExpiredDomains.net. 
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Now that we covered that, let's start with PageRank. There are still a lot of people who think 

that PR is not in the game anymore, but they couldn't be more wrong - well, at least half wrong. 

You see, PR is actually getting updated on a daily basis, but those updates are not public. Think 

of PR as a hypocrite who shows its public face to you when it actually might have a whole 

different one behind the mask. So, the private PR gets daily updates, but only Google is aware 

of those, while the public PR gets updated once or twice per year. What does this mean? 

It means that PR is still an SEO player, however, it is not 100 percent reliable or accurate. For 

example, you might be looking at some website with PR0, but on the "back-end", this site 

might already be PR3, because it has a gained few PR4 backlinks and a PR5 backlink maybe, but 

the public PR is still not updated so we don's explicitly see that. 

This is where tools such as Majestic SEO and Ahrefs come into play. We can use those to check 

the backlinks portfolio of an expired domain to make sure that it is looking good. 

This possible difference in private and public PR is exactly what we will use. We will find such 

domains that are a hidden PR2 or PR3 or even more, and we will register them. Now, because 

publicly these domains will still look like they are PR0, chances are no one would be auctioning 

them or would have registered them. So you will end up with a PR3 domain for the registration 

price which will be around $10 depending on the TLD. 

Basically all you need for a domain to be a strong PR2 or even a weak PR3 is a single PR5 

backlink. In order to find those (the PR5 pages pointing to expired domains), we will be 

using blogrolls. If you don't know what a blogroll is, it is basically a page that lists links to other 

blogs. Simple as that. So we will find such blogrolls which have a PR of at least 5, and we will 

check all of their outbound links to see if any domain has expired. Potentially, we can find 

hundreds if not thousands of expired domains using this simple method that I am about to 

share with you so hold on to your knickers. 

What can you do with such domains once you register them? Well, depending on the domain's 

metrics in the face of DA, PA, TF, CF, backlinks, previous content, number of previous owners, 

etc, you can use it as a: 

 Money site - starting a money site from ground zero is quite difficult. You have to wait a 

while before you begin seeing some traffic, sales, etc. However, if you use a domain that 

already has some background, you will have a head start. If the expired domain you 

found looks nice in terms of backlinks and has an aesthetic name, go for it. 
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 PBN site - you can simply add this site to your own private blog network or you can use 

it as a feeder site in FBN (our tutorial and review here) to squeeze even more links from 

it. 

 Or you can even sell it - you can list an auction on GoDaddy and try and sell the domain 

once the public PR gets updated. A nice PR3 domain goes for around $100 so this is a 

~1000% ROI if you pull it off. 

That's basically it. Now, it's time to find us some nice and cheap high PR expired domains. 

A Step-By-Step Tutorial On Finding Cheap 

High PR Expired Domains 

The first thing you will need is either Scrapebox or GScraper. Both will get the job done. For this 

tutorial, I will be using Scrapebox, because I already have some nice proxies at hand courtesy of 

GSA Proxy Scraper (check out the ultimate GSA PS tutorial), and because I am more familiar 

with it. You can also opt to use better quality proxies, for example, the ones from BuyProxies 

which will get the job done faster, but it's not mandatory. The ones from GSA Proxy Scraper will 

work like a charm. Without a further a due, let's find those expired domains we've been talking 

about. 

Step 1. Finding Referring Sites 

In the first step, we will be finding blogroll pages that will contain external links to domains that 

might have expired. Now, you can do this in 2 ways - niche specific, or more general. I decided 

to go with the first one, so I gathered some keywords in the weight loss niche from Google's 

Keyword Planner: 

Weight Loss Keywords 

Step 1.1. Preparing Scrapebox 

Now fire up Scrapebox and paste the keyword "blogroll 2005" in the "Harvester". This keyword 

will basically show blogroll pages from 2005 in the SERPs, so that Scrapebox can, well, scrape 

them. Why 2005? Because we want to go back at least 5 - 10 years to make sure that these 
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blogroll pages contain links pointing towards expired domains. The next thing we want to do is 

merge this keyword with our weight loss keywords. We end up with a total of 801 keywords: 

 

Step 1.2. Scraping For URLs Pointing at Expired Domains 

At this point we are ready to start up the harvesting process. Time went by, and after a little 

over 40 minutes the "Harvester" finished its work. The end result was 141,800 target URLs: 
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Step 1.3. Filtering the Referring URLs 

Now it's time to filter these out. The first thing we want to do is remove duplicate URLs. Click 

on "Remove/Filter" and then select "Remove Duplicate URL's". After the clean, we are left 

with 28,097 unique URLs. The next thing we want to do is check each URL's PR and then remove 

all URLs with a lower PR than 5. So click on "Check Pagerank" and then select "Get URL 

Pagerank". 

With our 28k URLs, this will take quite a while. I just want to note that the process is usually 

much faster with GScraper because it has those in-built proxies which are in the thousands, 

meaning you can afford to run the PR checker at a much higher thread count. 

Time went by again and the PR checking finished in just 48:44 minutes at 10 connections and 0 

RND delay. Again, I used my daily proxies from GSA Proxy Scraper - this has been a good day for 

public proxy scraping. I guess I hit a happy proxy hour or something. Anyway, all of the 28,097 
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URLs now have a PR. The next thing I want to do is sort the URLs by PR and remove any URL 

that is not PR5 or higher. This final filter of the first step of this expired domains tutorial leaves 

me with 67 URLs a.k.a. the source URLs: 

Source URLs 

And there you have it. These are our referring URLs which potentially point to expired domains. 

We should check them don't you think? 

Step 2. Finding The Expired Domains 

First of all, I will export my 67 referring URLs from Scrapebox to a file named "source urls". The 

naming part is extremely important and should not be overlooked. If you start naming your files 

whatever, you will lose track of their contents. And trust me, we will be creating a lot of files 

throughout this cheap expired domains tutorial. 

Step 2.1. Configuring Xenu 

The next thing I want to do is start up Xenu's Link Sleuth, which is a free software and will help 

us check all of the outbound links on each of the our 67 source URLs. Install the software and 

fire it up. Then go to "Options" -> "Preferences..." and change the "Maximum depth" setting 

to "1". I think the default is "999". This means that Xenu will check only the outbound links on 

our 67 URLs. Adjust the thread number according to your internet speed and machine 

configuration and click "OK": 
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Step 2.2. Finding All Outbound Links on Our Referring URLs 

Now it's time to run Xenu. Click on the "File" menu, select "Check URL List" and import 

the "source urls" file. You will see Xenu go to work. Depending on the number of threads you 

are running, this can take a while. I set it to 100 because I got some wicked Internet connection, 

and in 19:04 minutes it was done. After Xenu finishes, click on the "File" menu and 

select "Export to TAB separated file...". Name the file "expired domains unfiltered" and save 

it. So, out of our 67 referring URLs, we have found a total of 35,031 outbound links, each of 

which could potentially be an expired domain name. 

Step 2.3. Filtering the Outbound Links 

After that open the text file in Excel and expand the first, second, and third columns. Here's 

what I'm looking at: 
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So the first column is the URL, the second column is the status code, and the third one is the 

status text as shown in Xenu. That's what we will be looking at. We need all URLs which have 

status text "no such host". This means that the domain has expired. So quite simply select 

the "Status-Text" column and sort it from A-Z. Then simply search for "no such host". Hopefully 

it will take you to the first URL that has such a status text. 

After this you have to select all of the URLs that have "no such host" status and copy them to 

your clipboard. Okay. So far so good. Now switch back to Scrapebox and import the URLs you 

just copied into the clipboard - click "Import URL List" and select "Paste/Replace from 

Clipboard (replace current list)". We end up with a total of 1,145 expired domains. Now, let's 

clear them up a bit. 

Step 2.4. Filtering the Expired Domains 

The first thing we want to do is remove duplicate domains - click on "Remove/Filter" and then 

select "Remove Duplicate Domains". After we apply this filter we are left with 1,024 expired 

domains. Then click "Trim to Root". We need just the domain names, not the page URLs. And 

so, these are our expired domains guys. Finally, export them - click on "Export URL List" and 

then select "Export as Text (.txt)". Name the file "expired domains" and proceed to the next 

step of our expired domains tutorial. Just for reference, here are the 1,024 domains we have 

found in this tutorial: 
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Expired Domains 

Step 3. Checking The Expired Domains For 

Availability 

Now, 1,024 domains are quite a lot. If you went out and tested each one separately, you'd 

waste a lot of time. This is where GoDaddy's bulk domain checker tool comes in handy. We 

have a limit of 500 domains per check, but that's cool. 

Step 3.1. Cleaning the Domain Names 

Now, before we paste our domains in there, we want to remove the "http://www." portion in 

front of each of them. We do this by going to Ohashi US and pasting in our 1,024 domains. After 

the clean, scroll down to copy your clean domains. 

You will see that there are now 838 domains left since the cleaner removed some incorrect 

domains or simply didn't support a certain domain TLD. Now copy those 838 clean expired 

domain names and paste them into the "expired domains" file to replace the old dirty 1,024 

expired domains. At this point we are ready to bulk check on GoDaddy. 

Step 3.2. Bulk Checking the Expired Domains on GoDaddy 

So open up the "expired domains" and copy the first 500 domains. Paste them into the bulk 

checker tool and click "Go": 
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As you see, out of the first batch of 500 domains, 150 are available for registration. The rest are 

taken or incorrect. Not too shabby huh? Now copy all of the available domains and save them 

to a new file called "available expired domains". Let's check the remaining 338 domains. Again, 

the same process. It results in another 106 available expired domains. 

Copy and paste them into the "available expired domains" file. We end up with a total 

of 256 available expired domains. Remember when 256 MB RAM was huge? Anyway, now it's 

time to look at some domain metrics - I'm talking about PA, DA, TF, CF, etc. We have to know 

all of these stats before we even think about registering any of these 256 domains. Remember, 

all of them have at least one PR5 link pointing at them and they all go for the price of 

registration which is around $10. 

Step 4. Checking The Metrics Of The Expired 

Domains 

Now checking all of these domains for all of the important metrics can be a bit tricky. Sure you 

have free tools that check PA, DA, TF, CF, etc, individually but you want a free tool to show all 

of these in a single table right? Well, I got some good news. There is actually such a free 

tool which does all of this in a single user interface and it's called Netpeak Checker. It's 
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completely free - all you have to do is create an account when you start up the software and 

you are good to go. 

Then you want to go to "Settings", and you configure your Moz, Ahrefs, and Majestic accounts 

so that it can start getting some metrics from these 3rd party services - if you don't have Ahrefs 

and/or Majestic, skip them. You can get a free Moz API key from here, and you can register free 

accounts on both Majestic  and Ahrefs. However, keep in mind that both Ahrefs and Majestic 

have a daily usage limit for free accounts and we need those metrics, especially the Majestic 

ones for all of the domains. 

You are also going to need a bunch of proxies - either fresh ones from GSA Proxy Scraper, or 

beast ones like the ones from BuyProxies. I went with the latter just because I run the software 

at just a few threads, so I can use some of my GSA Search Engine Ranker proxies. The other 

thing you will need (not mandatory) is an AntiGate key. Yes, there will be captchas popping up 

here and there and if you don't have the time to solve all of them manually, I suggest you head 

over to AntiGate and you purchase some captchas. I set the threads of Netpeak to 5 and I 

disable Ahrefs and Yandex. 

Now, because I know that most people will not have Majestic subscription, I will show you how 

you can get TF, CF, and other relevant metrics for free and then how you can add them to the 

metrics we get from Netpeak Checker. So in a sense, you will get all of the important metrics for 

the expired domains without spending a single dollar. Here's how you do it. 

First, you will need to setup your metrics - Netpeak Checker shows a lot of metrics by default, 

but in our case, we don't need all of them. Select the following: 

 PR 

 Index domain 

 Moz 

 Alexa 

 Domain Age 

 Bing 

You can also get social metrics from Facebook, Twitter, Google+, VK, etc, but we really are not 

looking for those since our domains have probably expired for quite a while and all of the social 

stats will show zero. 
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At this point all you need to do is click the "Load" button and copy paste all of the 256 expired 

domains from the "available expired domains" file. Click "Save" and prepare for the show. 

Now, depending on the number of threads and the number of domains you loaded, this can 

really take a while. Hit the "Start check" button and watch as the metrics update. After about 

an hour, Netpeak Checker finished the job for our 256 expired domains. Take a look: 

 

I sorted the results by PR and as you can see, we have a number of domains above PR0. But as 

we explained, PR can both be a good and a bad indicator for an expired domain, however, a 

PR4 is still not so bad as a start. The rest of the metrics come mostly from Moz and we also 

have the domain age according to Web Archive, which is a good pointer and tells us a lot about 

the domain's history. 

Now, before you start picking out domains for manual investigation, you want to add metrics 

from Majestic as well and here's how you do that. First of all, click the "Export" button and save 

the domain metrics to a file called "expired domains metrics". Good. The next thing you want 

to do is download the free trial of Market Samurai, or if you have the full version, just use that. 

Simply create a new project and click on the "SEO Competition" tab. Before we import our 

domains into the tool, we need to once again clear them from the "http://" portion. 

Open up the "expired domains metrics" file and copy all of the domain names. It is important 

that we copy the domains in the exact same order that they are as in that file. Now, we need to 

clear them from the "http://" portion otherwise, Market Samurai will not show accurate 
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Majestic statistics. This is extremely important. So open up Ohashi US again and clean the 

domains. 

Now click "Add custom URLs" and paste the cleared domains. Then click "Add URLs" and wait 

for Market Samurai to do its thing. When it's done, you will be looking at something similar to 

this: 

 

As you can see, we now have Majestic metrics for all of our 256 domains. Now let's add them to 

the "expired domains metrics" file with all of the other statistics. Click "Export" and name the 

file "expired domains market samurai metrics". 

Now fire up Excel and open up both that file and the "expired domains metrics" file. What you 

want to do is simply insert 4 columns from the "expired domains market samurai metrics" file 

into the "expired domains metrics" file - CF, TF, RDD, and BLD. In order of appearance: 

 CF - Citation Flow. 

 TF - Trust Flow. 

 RDD - the total number of unique domains pointing at the specified domain. 

 BLD - the total number of external backlinks pointing at the specified domain. 

As you remember, the domains in both files are in the same order - sorted by PR, so you can 

simply copy and paste each of these 4 columns from the "expired domains market 
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samurai" file into the "expired domains metrics" file. And there you have it. The final file with 

all the metrics about the 256 expired domains we found in this tutorial: 

Expired Domains Metrics 

That wasn't so hard now was it? For those who do not have time to do all of this, there are 

always online marketing services such as Register Compass for example. You simply paste in 

your domains and it will show you all of the metrics you will ever need - PR, Moz metrics, 

Majestic metrics, domain age, number of archives, buy now price, registrar, auction, topic, and 

a lot more. But as you probably guessed, it's not free. 

Anyway, back to our expired domains tutorial. So far, we have jumped through hoops and 

ladders, but we have found 256 expired domains available for registration for about $10. And 

now we possess all of the metrics we need in order to choose the best domains out of these 

256, register them for the standard fee, and use them in the appropriate way. 

Some of them might be great for joining your PBN, some of them might be eligible for 

immediate auction - you must analyze all of them and decide. And maybe, just maybe, you have 

stumbled upon a beautiful gold nugget that is perfect for a money site. That is when you really 

hit the jackpot. And it all starts with the keywords you select when you scrape for referring 

URLs. 

I want to also point out that some of the referring URLs might not be DoFollow, so you'd also 

want to account for that. You can either filter the outbound links when you scan them with 

Xenu and remove all of them which are redirected via NoFollow links. Remember, a NoFollow 

backlinks doesn't pass on link juice. 

I left all of them in this tutorial, because I wanted to find all kinds of sites - both quality and 

spammed to hell - so you can get a taste of what's lurking out there in terms of expired 

domains. This concludes the step-by-step tutorial, but we are not done yet. We have a lot more 

work to do. Let's get to it. 
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How to Tell if an Expired Domain is Worth 

Registering 

When we are out hunting for expired domains, we have to be extremely careful. There are 

many domains out there that make a great first impression, convince people to purchase them 

at a suspiciously reasonable price, and then cause them regret. Just think about it. Do you have 

any idea how many other people and drop catching services are out there on the prowl for 

expiring domains? 

I mean, the chances of a domain expiring and no one re-registering immediately are quote slim. 

So if you find a PR5 domain for example, that has been dropped, but not re-registered 

immediately, you must first perform an in-depth analysis of said domain. You must always be 

smart when it comes to choosing expired domains. Fortunately, I will share with you, one of 

the best expired domain analysis strategies. And here it is: 

The absolute first thing you want to look at when you find a statistically good looking expired 

domain is the, well, domain name. 

The Domain Name 

It can tell you a lot more than you probably think it can. For example, the domain 

name www.fdzptrhg.com is probably not looking good on the back-end even if, for example, 

Google shows it to be a PR2 site. Domain names like this are usually spammed like hell and you 

don't want to have any doing with them. 

Then again, if you have a decently looking domain name, you should probably investigate it 

further, especially if it has words in it which look like a real person's name. These are usually 

personal blogs in specified niches which might have gotten to some higher level, but the owner 

later moved on to something else. For instance, from the 256 domains we found, we have the 

domain name www.michellekaufmandesigns.com. 

Now, the next thing you want to look for in the domain name is some words of a product or a 

niche. For instance, we found the domain www.vigrx101.com - this domain is in the "stand up 



captain" business. It is PR3 so I can be sure that it has at least one PR5 backlink and probably a 

few PR4 and PR3 backlinks, but we will talk about the backlinks inspection in a minute. 

In the end, the domain name is the first "metric" which will point you towards using the 

domain as a money site, as a PBN site, or to sell it. Next stop, PR. 

The PR 

We already said that at the beginning of this expired domains article - PR is not a flawless 

indicator of a domain's quality. But, it is still a good indicator. A PR3 domain probably has 

several nice high pr backlinks. However, because there is a difference between private and 

public PR, we want to check those backlinks to make sure they are still alive and well. 

The same thing goes for a PR0 site - it might have gotten a nice PR5 backlink for example, but it 

probably got dropped before Google could account for it and the domain remained PR0 when it 

is a hidden PR2 or PR3. This is called the game of detecting a fake PR, but I will not go into more 

detail about this today. Most of my time analyzing a certain expired domain is focused 

on backlinks investigation. 

The Backlinks Portfolio 

Okay. After looking for quite a while at all the metrics of the 256 expired domains we found, I 

think that www.adclixa.com will illustrate this part the best. It is PR3 (as of now), and the 

domain name is also looking well. It has 31.43 PA and 18.38 DA with MozRank sitting at 4.03. 

According to Moz, the domain has 105 backlinks which is just at that sweet spot. You don't 

want too many backlinks because if that's the case, then the domain is probably spammed 

hard. 

Majestic Metrics 

If we have a domain with 30k links for example, chances are this domain has been blaster by a 

spammer. So overall Moz metrics are looking good for adclixa.com from our "expired domains 

metrics" file. I think that the DA is a bit low considering the fact that this domain is 

supposedly PR3, but let's see what Majestic has to say about that: 
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First off, Trust Flow and Citation Flow. You can see that they are almost identical to one 

another which is a great indicator. I won't delve into the depths of TF and CF here, but when it 

comes to Majestic, you want them to be really close to one another. If you have an expired 

domain with 5 TF and 30 CF for example, it is a good indicator that this domain has a bunch of 

spam backlinks pointing at it. 

So adclixa.com, being 8 TF and 9 CF, looks good at first glance. Basically, this is the situation 

with TF and CF - if you have a lot of low quality backlinks pointing at an expired domain, its 

Trust Flow will be extremely low compared to its Citation Flow. That's it. Usually you'd want TF 

and CF to be double digits and still close to each other, but even though adclixa.com doesn't 

meet this criteria, it's still a viable candidate for registration so far. 

Next stop is external backlinks. As you can see, the expired domain we are analyzing has 195 

backlinks (according to Majestic - this might not be 100% accurate) from 40 unique domains. 

So on average, each domain has 5 backlinks pointing to adclixa. Generally this is good. A better 

situation would be if the average backlinks per domain were 3 or even 1, but this is still totally 

acceptable. 

You also want to look at the TF to CF diagram. What you want to see is links around the middle 

line which are going upwards. In our case, the degree of the figure the backlinks are creating 

needs to be tilted a little bit to the right, but so far I'm liking the "back-end" of this expired 

domain. 

Then we move on to backlinks breakdown and anchor texts. Usually, this is where an expired 

domain shows its true colors. Let's start with the backlinks breakdown. As you can see, we 

have a healthy looking split between DoFollow and NoFollow backlinks. I know that many 

people hate NoFollow links, but they are absolutely vital for a domain's health. You can't just 

have DoFollow links - it's just not natural. 

And plus, NoFollow links also bring value to the table. It might not be in the face of link juice, 

but a number of case studies have shown that Google does account for these backlinks one way 

or another. Now divert your attention to the "Live at La st Crawl" and "Deleted" links. Adclixa 

is looking good there as well. Not too many backlinks have been deleted from the domain's off-

page portfolio which is a great sign. 

http://www.inetsolutions.org/get/majestic-seo/
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Now as for the types of backlinks, I am seeing a more than the usual amount of images links, 

but it's understandable. Apparently this domain was in the "Advertising" niche in which images 

are of critical importance. We still have 3 times more text links, so we are good. 

Now divert your attention to the anchor text distribution pie chart. You want to see a lot of 

brand anchors here, a bunch of generic anchors, and a low amount of keywords. That's how a 

healthy anchor text diversification looks like nowadays. And as you can see, adclixa.com is 

looking good. It has about 60% branding anchors, about 15% generic anchors, and just 2% 

exact match for 2 keywords. The remaining ~24% are split among naked URLs, other generic 

anchors, and other keywords. 

The anchor text distribution of adclixa is looking extremely natural. As I told you, many expired 

domains fail here because they have keywords at 10% or more each. That's just too much and it 

tells me that the domain is probably some old site from the pre-Penguin era. 

The other thing many domains fail at here is relevance. For instance, we clearly see by the 

name of our domain that it was involved in the "Advertising" niche. But, you will find many 

expired domains out there that have irrelevant anchor texts. So watch out for those as well. 

The final metric we want to look at is the backlinks themselves. Majestic lists 5 backlinks below 

the backlinks breakdown and anchor text pie charts and it is a good practice to inspect those. 

For instance, you do not want to see any deleted backlinks out of those, because usually, these 

are one of the best ones for the domain. Just switch to the "Backlinks" tab and analyze. 

I see a couple of PR3 backlinks, a bunch of PR4 backlinks all DoFollow so far and also, a few 

backlinks from Warrior Forum - sadly those are NoFollow. In addition, we have 

several PR2 backlinks and a bunch of high PR blog comments - PR1 to PR4. And I have analyzed 

just the first 10 backlinks which Majestic shows. Keep in mind that adclixa.com has a total of 40 

unique domains referring to it, so there are 30 left which possibly also have a nice PR to them. 

Of course, you'd want to inspect those as well just to make sure. I have seen more than enough 

and I believe that the PR3 which this domain has is quite real actually. Keep in mind that there 

is also one at least PR5 backlink pointing at this domain. After all, this is how we found it. 

Majestic might have not indexed it or something, but it's there for sure. 
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Open Site Explorer Metrics 

Now, we do not want to limit ourselves to just Majestic SEO's stats. We also want to check 

some other great third party tools, namely, Open Site Explorer: 

 

We already know the PA and DA of adclixa. The spam score of 4 is relatively good, but as you 

can see, OSE shows less links than Majestic. We see a bunch of Warrior Forum threads which 

seem natural. Lower on the OSE analytics page we can see more of the links and all of them are 

looking good - decent PA, DA and spam score. But the most important part is the fact that the 

links are all niche relevant to our expired domain. 

At the end of the backlinks investigation, we have found strong evidence that adclixa.com is a 

pretty legit PR3 expired domain. The backlinks look great, the Moz metrics look great, and the 

https://moz.com/researchtools/ose/
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TF and CF relationship is good. But, we are still not going to jump to any conclusions here. Thus 

the analyzing process continues. 

The History of the Expired Domain 

Here comes the history lesson. We head over to the Wayback Machine and we search for 

adclixa's records: 

 

It looks like the domain is actually not that old. It was started around June 2013 as far as I can 

see. Okay. This is good. Now it's time to look at some of the domain's historic photos: 

http://archive.org/web/
http://www.inetsolutions.org/wp-content/uploads/2015/09/Expired-Domain-History-Analysis.jpg


 

Just as we predicted, the website was in the "Advertising" niche. Basically, it was an advertising 

company as far as I can see. However, when I looked at 2014 records, I found a different look 

with some content on the homepage. The content was not relevant to the advertising niche 

which made me analyze further. 

Oh I see. So in 2013, the website owner used the domain as a money site perhaps and then in 

2014, probably it gained some PR, so they used it as a PBN site. It has several posts from 2014 

in different niches that link to other domains. This means that the website was probably 

dropped after 2013 and bought by someone else in 2014. Let's verify that. Go to Domain 

Tools and search for adclixa.com: 

http://whois.domaintools.com/
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Nope, I was wrong. There has been only 1 registrar of the domain so far. Oh well, perhaps the 

official creator got into something else and decided to use the domain as a PBN site. Anyway, 

this doesn't concern us that much. The domain is still looking solid. 

The Check on Google 

The final step of the expired domain analysis process is to simply search for the site in Google: 

http://www.inetsolutions.org/wp-content/uploads/2015/09/Expired-Domains-Registrars-History-Check.jpg


 

Okay, that's interesting. The first result is a listing from Flippa. For those unaware, Flippa is a 

website trading place - people can buy and sell whole websites there. Now this will be 

interesting. Let's see what the page shows us: 

https://flippa.com/
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So the site was basically an ad exchange with around 100 publishers captured on it at the time 

of sale. A total of $17 have been made from the site. Impressive. At the time of this listing, 

which was about a year ago, the ad network was getting over 2k banner impressions per day, 

so there definitely was some nice traffic flowing to the site. Now as far as I can see, nobody 

bought the site so it got dropped. 

The rest of the pages we see in the SERPs are just some sites that have the same or similar 

words in their URLs or content, but they have nothing to do with our expired domain of 

interest. And that concludes our expired domain analysis process. 
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To Buy or Not to Buy? 

Bottom line is, adclixa.com is a decent expired domain as we saw from our in-depth expired 

domain analysis, and I will actually register it in a minute. It is not a eligible for a money site 

from what I've seen, but I will surely use it somehow - probably sell it for some profit. If I do 

that, I will update the post and share with you my ROI. Here's proof that I really registered the 

expired domain adclixa.com: 

 

http://www.inetsolutions.org/wp-content/uploads/2015/09/Registered-Expired-Domain.jpg


Can you see? I paid a total of 1.13 euro for it. I used a GoDaddy discount coupon which gave me 

a huge discount on .com domain registration - keep in mind that you can only use one such 

coupon per account. 

Summary 

Over the course of this step-by-step tutorial on finding cheap high PR expired domains, we got 

some niche keywords, took advantage of old blogrolls, found our referring URLs, removed those 

of them with PR lower than 5, got all outbound links on the remaining referring URLs, kept all 

outbound links which were expired domains, filtered the expired domains, cleared their domain 

names, checked all of them for availability, checked all of the important metrics of the available 

expired domains, and we found a bunch of domains worth registering. 

And the best part is that all of this cost me 1.13 euro. That's it. No subscriptions were 

purchased, no software was bought - we used only 100% free online marketing tools to get the 

job done. So you see, finding quality high PR expired domains not always requires you to have 

capital. If you know how to look for those gold nugget expired domains that no one else knows 

about, all you need is a just few bucks. 

And of course there's always the alternative - you can simply purchase a software like Domain 

Hunter Gatherer (our tutorial and review) and have all the hard work done for you instead of 

doing it yourself. DHG will find you some expired domains with just a few configurations and a 

click of a button. But I assure you that if you employ this finding expired domains method which 

I shared with you for just one day, by late night, you will probably have several decent domains 

registered for just a couple of bucks. Your choice. 
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